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NOTICES 

COPYRIGHT AND TRADEMARKS 

© 2012 Christie Digital Systems USA, Inc. - All rights reserved.

All brand names and product names are trademarks, registered trademarks or trade names of their 
respective holders.

REGULATORY

The product has been tested and found to comply with the limits for a Class A digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the product is operated in a commercial environment. The product generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. Operation of the product in a residential area is 
likely to cause harmful interference in which case the user will be required to correct the interference at the 
user’s own expense.

This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

이 기기는 업무용 (A급 )으로 전자파적합등록을 한 기기이오니 판매자 또는 사용자는 이점을 주
의하시기 바라며 , 가정 외의 지역에서 사용하는 것을 목적으로 합니다 .

GENERAL

Every effort has been made to ensure accuracy, however in some cases changes in the products or 
availability could occur which may not be reflected in this document.  Christie reserves the right to make 
changes to specifications at any time without notice.  Performance specifications are typical, but may vary 
depending on conditions beyond Christie's control such as maintenance of the product in proper working 
conditions.  Performance specifications are based on information available at the time of printing.  Christie 
makes no warranty of any kind with regard to this material, including, but not limited to, implied warranties 
of fitness for a particular purpose. Christie will not be liable for errors contained herein or for incidental or 
consequential damages in connection with the performance or use of this material.

The product is designed and manufactured with high-quality materials and components that can be 
recycled and reused.  This symbol  means that electrical and electronic equipment, at their end-of-
life, should be disposed of separately from regular waste. Please dispose of the product 
appropriately and according to local regulations.  In the European Union, there are separate 

collection systems for used electrical and electronic products. Please help us to conserve the environment 
we live in!

GENERAL WARRANTY STATEMENTS

For complete information about Christie’s limited warranty, please contact your Christie dealer.  In addition 
to the other limitations that may be specified in Christie’s limited warranty, the warranty does not cover:

a. Damage occurring during shipment, in either direction.
b. Damage caused by misuse, improper power source, accident, fire, flood, lightning, earthquake or 

other natural disaster.
c. Damage caused by improper installation/alignment, or by product modification, if by other than a 

Christie authorized repair service provider.
d. Problems caused by combination of the equipment with non-Christie equipment, such as distribution 

systems, cameras, video tape recorders, etc., or use of the equipment with any non-Christie interface 
device. 

e. Failure due to normal wear and tear.
f. Warranty does not cover image retention.

PREVENTATIVE MAINTENANCE

Preventative maintenance is an important part of the continued and proper operation of your product. 
Please see the Service Manual for specific maintenance items as they relate to your product.  Failure to 
perform maintenance as required, and in accordance with the maintenance schedule specified by Christie, 
will void the warranty.



SOFTWARE LICENSING AGREEMENT
1. This Software License Agreement (the “Agreement”) is a legal agreement between 
the end user, either an individual or business entity, (“Licensee”) and Christie Digital 
Systems USA, Inc. (“Christie”) for the software known commercially as Christie® 
JumpStart that accompanies this Agreement and/or is installed in the server that 
Licensee has purchased along with related software components, which may include 
associated media, printed materials and online or electronic documentation (all such 
software and materials are referred to herein, collectively, as “Software”). If Licensee 
does not accept the terms of this Agreement, Licensee will return the Software to 
Christie in accordance with Christie's standard return policy in place from time to time. 
BY DOWNLOADING, INSTALLING, ACTIVATING OR USING THE SOFTWARE, THE 
LICENSEE IS AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT.
2. The Software contains third party software programs which require notices and/or 
additional terms and conditions. Such required third party notices and/or additional 
terms and conditions are located in the Software install location (C:\Program Files 
(x86)\Christie Digital Systems\JumpStart\
Licenses). By accepting this Agreement and using the Software, you are also accepting 
any such additional terms and conditions applicable to the third party software 
programs. To the extent any license for third party software programs requires an offer 
to provide source code for those third party software programs, this Agreement 
constitutes such an offer. You may request more information or a copy of such source 
code by contacting Christie at open.source@christiedigital.com. In conjunction with 
such request, provide the Christie Product Number, the Software version and the 
Product Serial Number (if applicable). If applicable, a nominal cost to cover shipping 
and media charges will be charged.

License and Restrictions
3. Ownership of Software: Christie retains title and ownership of all rights, including 
copyright and all other intellectual property rights, in and to the Software and all copies 
thereof, regardless of form or media. This license is not a sale of any rights in or to the 
Software or any copy thereof. Licensee acquires no right whatsoever to the Software 
except the right to use the Software in accordance with the terms of this License. 
4. Grant of License: Christie grants to Licensee a single license providing a 
nonexclusive and non-transferable right to use, for personal or internal business 
purposes, the executable version of the Software, as long as Licensee complies with 
the terms and conditions of this License. Christie reserves all rights not expressly 
granted to Licensee. 
5. Copy Restrictions: Where the Software is provided for download onto a personal 
computer or similar device, Licensee may make as many copies of the Software as is 
reasonably required for Licensee's own use with the Device. Licensee may also make a 
backup copy of the Software which may be used only for reinstallation of the Software. 
Where the software is pre-installed on a server, Licensee may keep one copy of the 
Software solely for backup or archival purposes. Unauthorized copying or distribution 
of the Software is expressly prohibited unless agreed to in writing by Christie. Licensee 
must reproduce and include the copyright notice on any backup copy of the Software. 
Licensee may not remove or alter any proprietary rights or copyright notice or 
identification which indicates the ownership of the Software. 
6. Use Restrictions: Licensee will not (a) modify, adapt, decompile, disassemble, 
reverse engineer, or otherwise attempt to derive the source code for the Software, or 
create derivative works based on the Software; (b) assign this Agreement or 
redistribute, encumber, sell, transfer, lease, or grant a sublicense of the Software or 
the license granted herein or otherwise transfer rights to the Software to any person or 
entity except as and when expressly permitted by this Agreement; (c) directly or 
indirectly, export or transmit the Software, either alone or bundled with other software, 
to any country to which such export or transmission is restricted by any applicable laws 
without the appropriate prior written consent of the applicable government entity or 
department; and (d) publish or otherwise disclose the Software for others to copy. 
Licensee will make reasonable efforts to prevent any unauthorized use of the Software 
by third parties and will advise Licensee's employees of the restrictions upon use 
restrictions herein.
7. Upgrades and Updates: While Christie is not required to do so, Christie may 
provide Licensee with upgrades or updates to the Software, including but not limited to 
files that are delivered to Licensee via online transmission or otherwise to “patch” or 
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otherwise modify or enhance the software program. This Agreement covers any 
upgrades or updates to the Software that Licensee may obtain from Christie or one of 
its authorized vendors, unless the upgrade or update comes with its own license 
agreement. If Licensee decides not to download or install an upgrade or update 
provided by Christie, Licensee understands that this could put the Software at risk to 
serious security threats or cause the Software to be come unstable. Christie may, at its 
option, cause an upgrade or update to apply automatically.

Maintenance and Support
8. Christie may, in its sole discretion and without any obligation, provide maintenance 
and support services related to the Software (“Support Services”). Support Services 
are governed by Christie’s policies and programs described in materials available from 
Christie. Any supplemental software code provided to Licensee as part of the Support 
Services will be considered part of the Software and subject to the terms and 
conditions of this Agreement. 

Warranty and Limitation of Liability
9. No Warranties: The Software is provided “as is” and Christie makes no warranty of 
any kind with regard to the Software. Christie will not be liable for errors contained in 
the Software or in connection with the performance or use of the Software. Christie 
does not warrant that the Software is free from any defects or that it will operate 
uninterrupted. Christie warrants that the media on which the Software is distributed 
will be free from defects in materials and workmanship under normal use for a period 
of ninety (90) days from the date of delivery. Christie will replace any defective media 
returned to Christie within the ninety (90) day period. The foregoing is Licensee’s sole 
and exclusive remedy for breach of the warranty given pursuant to this Section. 
Christie does not make any other warranties, either express or implied, including, but 
not limited to, implied warranties of merchantability, fitness for a particular purpose, 
title and non-infringement with regard to the Software.
10. Limitations of Liability: IN NO EVENT WILL CHRISTIE BE LIABLE TO ANY PARTY 
FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, 
INCLUDING LOST PROFITS, LOST REVENUES AND LOST DATA ARISING OUT OF THE 
USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF CHRISTIE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
CHRISTIE SPECIFICALLY DISCLAIMS ANY WARRANTIES OR CONDITIONS, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR CONDITIONS OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE SOFTWARE AND 
ACCOMPANYING DOCUMENTATION, IF ANY, PROVIDED HEREUNDER IS PROVIDED “AS 
IS”. CHRISTIE HAS NO OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, 
ENHANCEMENTS, OR MODIFICATIONS.
CHRISTIE FURTHER DISCLAIMS ANY AND ALL REPRESENTATIONS RELATING TO THIRD 
PARTY SOFTWARE WHICH IS EMBEDDED IN THE SOFTWARE. Some jurisdictions do not 
allow exclusions or limitations of certain conditions or warranties. Only those 
exclusions or limitations that are lawful in Licensee’s jurisdiction will apply to Licensee 
and, in such instances, Christie’s liability will be limited only to the maximum extent 
permitted by law.

Termination
11. Christie may terminate this Agreement at any time and for any reason. Christie 
may also terminate this Agreement if the Licensee breaches or is in default of any 
obligation of Licensee under this Agreement. Upon termination of this Agreement, the 
Licensee will immediately (i) cease using the Software and (ii) uninstall the Software 
from any personal computers, servers or other devices (to the extent it is installed 
thereon). The Licensee’s obligation under this provision will survive the termination of 
this Agreement. 

General
12. Notices: Unless otherwise set forth in this Agreement, all notices, or other 
communications hereunder will be deemed to have been duly given when made in 
writing and delivered in person, by courier or deposited in the mail, postage prepaid, 
and registered mail, return receipt requested, and addressed to Licensee at the billing 
address supplied to Christie by Licensee, and addressed to Christie at Christie Digital 
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Systems USA, Inc., c/o Christie Digital Systems Canada, Inc. at 809 Wellington Street 
North, Kitchener, Ontario, Canada N2G 4Y7, with a copy (which will not constitute 
notice) to Christie’s Legal Department at the same address.
13. Severability and Waiver: Any provision of this Agreement which is held by any 
court to be unenforceable or invalid will be deemed severed from this Agreement, 
without affecting any other provision of this Agreement. No waiver by Christie of any 
particular default or omission committed by Licensee will affect or impair the right of 
Christie in respect of any subsequent default or omission of the same or a different 
kind. No delay or failure by Christie to exercise any rights in connection with any 
default or omission committed by Licensee will affect or impair Christie’s rights in 
respect of that particular default or omission or any subsequent default or omission of 
the same or different kind. In any event, time will continue to be of the essence 
without the necessity of specific reinstatement. 
14. Governing Law: This Agreement is governed by the laws of the State of 
California, without regard to its conflict of law principles. Any suit or action arising out 
of or in connection with this Agreement will be brought in the federal or state courts 
located in Orange County, State of California. Each of Licensor and Licensee hereby 
irrevocably submit to the jurisdiction of such courts for the purpose of such suit or 
action and expressly and irrevocably waive, to the fullest extent permitted by law, any 
objection it may now or hereafter have to the venue of any such suit or action in any 
such court and any such claim that any suit or action has been brought in an 
inconvenient forum.
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Introduction
This document provides information and procedures for using the 
Christie JumpStart client software. You use the JumpStart software to 
manage tiled displays with up to four video inputs. 

All users should have some understanding of Christie tiled displays and 
be familiar with Microsoft Windows functionality.

For information about setting up a JumpStart server and connecting it to 
a display wall, see the JumpStart Operations Guide (020-100803-xx). 

About Christie JumpStart
Christie JumpStart allows you to organize and manage content for 
display on large digital display walls. With Christie JumpStart, you can 
display multiple media files, Windows applications, and live video inputs 
on a 5-10 megapixel digital canvas. JumpStart is designed to work with 
Christie MicroTiles, but can also work with any Christie large-format 
digital display walls, such as Christie rear-projection and flat panel 
solutions.
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Introduction
Christie JumpStart Desktop

NAME DESCRIPTION

1 Content Pane Contains the content that you can add to your 
JumpStart display. 

2 Toolbar Contains buttons for commonly used tasks.

3 Canvas A visual representation of your JumpStart display. On 
the canvas, you can add, stretch, and remove 
windows.

4 Schedule Schedule the sequence and playback duration of 
windows.

1

2

3

4
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Introduction
The File Toolbar

ICON DESCRIPTION

Select a Christie JumpStart server.

Manage the list of JumpStart servers associated with the JumpStart 
client software. 

Create a new JumpStart scenario.

Open an existing JumpStart scenario.

Save a JumpStart scenario with a new name, leaving the existing 
scenario in place. 

Save a JumpStart scenario.

Rename a JumpStart scenario.

Delete a JumpStart scenario.

Activate the scenario displayed on the canvas.
JumpStart 1.0.1 User Manual 3
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Introduction
The Home Toolbar

Stop the active scenario.

Opens the About dialog box, showing JumpStart version and third-
party licensing information. 

ICON DESCRIPTION

Select a Christie JumpStart server.

Create a new JumpStart scenario.

Open an existing JumpStart scenario.

Activate the scenario displayed on the canvas.

Stop the active scenario.

Change the increments of the grid to which you can snap windows for 
alignment.

ICON DESCRIPTION
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Introduction
The View Toolbar

Selects all of the windows on the JumpStart canvas, so that you can 
move them together or delete all of them.

ICON DESCRIPTION

Show or hide the schedule.

Show or hide the name of each window on the canvas.

Show or hide the grid lines between virtual output devices (ECUs for 
MicroTiles) or actual output devices (for other displays).

Show or hide the grid lines between actual output devices. NOTE: 
For non-MicroTiles displays, the Outputs and Tile Boundaries 
check boxes have the same effect. 

Show a grid representing the screens or MicroTiles connected to the 
JumpStart server on top of the content windows or behind the 
content windows.

Zoom in to the canvas in 5% increments.

Zoom away from the canvas in 5% increments.

Fit the canvas to the current window.

Zoom the canvas 100%.

ICON DESCRIPTION
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Introduction
The Content Toolbar

Move the selected window forward one level.

Move the selected window backward one level.

Move the selected window to the front of the canvas.

Move the selected window to the back of the canvas.

ICON DESCRIPTION

Add a video file to the content panel. 

Add a picture file to the content panel. 

Add or remove an application on the content panel.

Add a color box to the content panel.

ICON DESCRIPTION
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Introduction
Minimum Hardware Requirements 
JumpStart requires the following minimum hardware specifications, for 
the JumpStart server and for any other computer that you install the 
JumpStart client software on. 

JumpStart Server
• Operating System: Windows 7 (64-bit)

• Framework: .NET 4.0 Full

• Memory: 6GB of RAM or higher

• Storage Space Required for Server Software: 1GB of available disk 
space

• CPU: 2.4GHz or faster 64-bit processor

• Graphics: DirectX 9 graphics device with WDDM 1.0 or higher 
drivers

• DVI Capture Devices: Datapath VisionRGB-E2

Client Computer
• Operating System: Windows XP (32-bit), Windows 7 (32-bit or 64-

bit)

• Framework: .NET 4.0 Client

• Memory: 2GB of RAM or higher

• Storage Space: 500MB of available disk space

Add a text box to the content panel.

Add a command to the content panel. 

ICON DESCRIPTION
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Introduction
• CPU: Pentium4 2.8GHz single core or faster 

Supported Media Formats

Required Filters
The JumpStart server uses the LAV Filter (version 0.45) Microsoft® 

DirectShow® media splitter and decoder to play video files. Removal or 
alteration of this software will cause JumpStart to no longer play some 
video file types. To reinstall this software: 

1. Insert the JumpStart CD-ROM into the DVD drive of the JumpStart 
server. Browse to the following location and launch the following 
executable:
\Prerequisites\LAV Filter\LAVFilters-0.45.exe. 

2. On the Introduction page, click Next. 

3. On the Select Destination Location page, click Next. 

4. On the Select Components page, click Next. 

Video Format File Extension

QuickTime .MOV 

Windows Media .AVI, .WMV (NOTE: Digital Video (.DV) and Motion 
JPEG (MJPEG) are not supported.)

MPEG .MP4, .MPG, .MPEG

Image Format File Extension

Portable Network Graphics .PNG

Graphics Interchange Format .GIF

Animated Graphics Interchange 
Format

.GIF

Joint Photographic Experts Group .JPEG, .JPG

Tagged Image File Format .TIFF, .TIF

Microsoft Bitmap .BMP
8 JumpStart 1.0.1 User Manual
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5. On the Select Start Menu Folder page, click Next. 

6. On the Select Additional Tasks page, under the Use LAV Splitter 
for these file formats section, select the WMV check box. Click 
Next. 

7. On the Ready to Install page, click Install.

8. On the completion page, click Finish. 

9. From the Start menu, select Programs > LAV Filters > LAV 
Filter Configuration. 

10. On the Video Settings tab, select 1 in the Threads for Multi-
Threading drop-down list. 

11. Click Apply. Click OK.

Performance Specifications
JumpStart can play back many different kinds of content in a schedule: 
pictures, videos, color or text boxes, software applications, and live 
input. A single scenario can contain up to 60 media windows, and each 
media window can have up to 3,000 media objects scheduled at different 
times within it. However, the amount of content which may be played 
back simultaneously is limited by the JumpStart server’s hardware. This 
section provides guidelines for the amount of content which may be 
played back simultaneously.

Note that these limits apply to displaying each type of content alone: 
video or images. If you want to display several videos and image content 
simultaneously, or run additional applications, performance may degrade 
before you reach these limits.
JumpStart 1.0.1 User Manual 9
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Video

Images and Color Boxes

Standard Guidelines
When displaying images and color boxes before or after other content in 
a scenario, JumpStart can display a combined 25 million pixels of images 
or color boxes simultaneously.

In this instance, individual static images or color boxes should not be 
larger than 6.25 million pixels. If you exceed this value in a scenario, 
images, color boxes, or videos may not be displayed correctly.

Here are examples of image combinations that would reach JumpStart’s 
maximum recommended capacity when displaying with other content in 
a scenario: 

• 4 images that are each 2500 by 2500 pixels

• 8 images that are each 1750 by 1750 pixels 

• 12 images that are each 1920 by 1080 pixels

Special Case - Static Content
If the images and color boxes remain static throughout the scenario, and 
are not preceded or succeeded by any other content, JumpStart can 

Video Resolution Number of Videos 
in Simultaneous 

Playback

Number of Videos 
per Output

1920 x 1200 (WUXGA) 
@ 60Hz 

4 3

720 x 480 (Standard 
Definition) @ 60Hz

16 12

Although limitations are provided using standard VESA 
resolutions, a wide range of non-standard resolutions — 
common with MicroTiles — are also supported within the 
equivalent bandwidth.
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display up to a combined 50 million pixels of images or color boxes 
simultaneously. 

In this instance, individual static images or color boxes should not be 
larger than 50 million pixels. If you exceed this value in a scenario, 
images, color boxes, or videos may not be displayed correctly.

Here are examples of image combinations that would reach JumpStart’s 
maximum recommended capacity when they are being shown alone:

• 1 image that is 7000 by 7000 pixels 

• 16 images that are each 1750 by 1750 pixels

• 24 images that are each 1920 by 1080 pixels. 

Capture Card Limitations
The D2R2-E DVI capture cards in the JumpStart server support capturing 
of the following resolutions:

• Digital: 640x480 (VGA), 800x600, 1024x768, 1280x1024, 
1600x1200, 1920x1080, 1920x1200 (WUXGA)

• Analog: 640x480 (VGA), 800x600, 1024x768, 1280x1024, 
1600x1200, 1920x1080, 2048x1536 (QXGA)

• HD Modes: 1080p, 720p, 576p, 480p using a Component HD-DVI 
connector (HDCP not supported).

• Supported Frequency: Resolution frequency supported up to 60Hz

Resolutions outside of the above list may still be captured by the D2R2-E 
capture card; however, quality is not guaranteed.

Remote Management
Although you can install the JumpStart client software on as many other 
computers as you wish, up to 5 users can use the JumpStart client 

High-bandwidth Digital Content Protection (HDCP) is not 
supported in JumpStart.
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software concurrently on other computers to connect to one JumpStart 
server. 

Recommendations for Best Results
Use of interlaced video signals connected as an external source to the 
JumpStart server is not recommended. This could produce visible image 
artifacts, such as missing lines, especially when viewed up close or if the 
video is upscaled significantly. 
12 JumpStart 1.0.1 User Manual
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Installation and Setup
This section provides information and procedures for installing and 
configuring Christie JumpStart.

Install Christie JumpStart
1. Insert the installation CD into the computer on which you want to 

run JumpStart.

2. Click Install Products.

3. Click Install JumpStart Client.

4. If prompted by any Microsoft Windows security warning dialog 
boxes, click Run. 

5. If you want to continue the installation, read the license agreement 
and then select I accept the terms in the license agreement. 

6. Click Install.

7. When the installation is complete, click Finish. 

Start Christie JumpStart
1. Log on to the computer on which Christie JumpStart is installed.

2. Click Start > All Programs > Christie > JumpStart.

3. Connect to a server. See Connect to a Server on page 16.

- or -

Add a server. See Add a Server on page 15.

Close Christie JumpStart
Click the close button in the upper right corner of the JumpStart window. 
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Uninstall Christie JumpStart
1. Click Start > Control Panel.

2. Click Programs and Features.

3. Right-click Christie JumpStart and select Uninstall.

4. Click Yes.
14 JumpStart 1.0.1 User Manual
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Using JumpStart
This section provides information and procedures for using Christie 
JumpStart.

Work with Servers
To display content, your display wall must be connected to a JumpStart 
server. The JumpStart server hosts all media content and it is managed 
by your JumpStart administrator.

Add a Server
1. On the File tab, click Manage.

2. In the Manage Servers dialog box, click Add.
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3. In the Server Details dialog box, enter a name for the server in the 
Name field. Choose a meaningful name so that you can distinguish 
this JumpStart server from any others you might have. 

4. Enter the IP address or host name of the server in the Address 
field.

5. Click OK. To close the Manage Servers dialog box, click OK.

Connect to a Server
On the File or Home tabs, click Select and select a server from the list.

Edit a Server Name or IP Address
1. Click File > Manage.

2. In the Manage Servers dialog box, select a server.

3. Click Edit.

4. In the Server Details dialog box, edit the server name in the Name 
field.

- or -

Edit the server IP address or name in the Address field.

5. Click OK. To close the Manage Servers dialog box, click OK.

Delete a Server
1. Click File > Manage.

2. In the Manage Servers dialog box, select the server you want to 
delete.

3. Click Delete.

4. When prompted to confirm, click Yes.

5. Click OK. To close the Manage Servers dialog box, click OK.

You can also add a server directly without the Manage 
Servers dialog box. To do this, on the File or Home tabs, 
click Select and then click Add & Connect.
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Work with the Canvas
The canvas is a graphical representation of your JumpStart display wall. 
You add windows to the canvas. A group of windows, along with the 
schedule of when and for how long they are displayed, makes up a 
scenario.

Change Viewing Options 
1. Click the View tab.

2. Select or clear these check boxes to change viewing options on the 
canvas: 

• Schedule: Select to show the Schedule pane in the lower 
right corner of the JumpStart application window. When the 
Schedule pane is visible, you can change the size of the 
canvas relative to the schedule pane. Move your pointer over 
the split bar between the canvas and the schedule pane until 
a double-headed arrow appears, and then drag the split bar 
up or down.

• Window Names: Select to show the window names on top 
of each window. 

• Outputs: Select to show lines separating the outputs (your 
ECUs) that are connected to your JumpStart server. 

• Tile Boundaries: Select to show the grid separating each 
MicroTile connected to your JumpStart server.

• Grid on Top: Select to show the grid lines over top of the 
windows. Clear to show the windows on top of the grid lines. 

Change the Zoom Level on the Canvas
To change the zoom level of the canvas in the JumpStart window, do one 
of the following: 

• Move the slider at the bottom of the JumpStart window to the right 
or left. 
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• Click the plus or minus signs near the slider at the bottom of the 
JumpStart window. 

• Click the View tab and then click Zoom In or Zoom Out. 

• Use the wheel button on the mouse to zoom in and out. 

• To fit the canvas to the window, click the View tab and then click 
Fit in Window.

• To view the canvas at 100 percent of its size, click the View tab 
and then click 100%.

Work with Scenarios
Scenarios are how you organize and display content on your wall using 
JumpStart. A scenario is a collection of windows that you want to show 
on your display wall, along with the order and timing of when and for 
how long they appear. You start and stop a scenario, much like you 
would with a play list in a media player. 

You cannot schedule scenarios to begin at a particular time. However, if 
a scenario is playing when the JumpStart server software restarts, 
JumpStart restarts that scenario. This feature allows a running scenario 
to be automatically restarted when the JumpStart server reboots (for 
example, after a power outage).

You must activate a scenario to view it on your display wall. You can 
create as many scenarios as you want, but can only have one active at a 
time. 

Create a Scenario
1. On the File tab, click New. A new, empty scenario grid appears on 

the JumpStart canvas.

2. Expand one of these lists in the left pane:

• Videos

• Pictures

• Applications

• Input Channels
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• Color Windows

• Text Windows

3. Click and drag content windows from the lists in the left pane to the 
canvas in the right pane. As you are developing your scenario, you 
can have more than 60 windows on your canvas, but cannot exceed 
60 when you save or activate the scenario. 

4. Repeat Step 3 to add additional windows to the canvas.

5. Click Save.

6. Enter a name for the scenario in the Scenario Name field.

7. Click OK.

Save a Scenario
1. Click Save on the File ribbon or the quick-launch toolbar.

2. Enter a name for the scenario in the Scenario Name field.

3. Click OK.

Activate a Scenario
Click Activate on the Home or File ribbons, or on the quick-launch 
toolbar. If you have made changes to the scenario since the last time you 
saved it, you are prompted to save the scenario.

If you save a scenario and specify the name of an existing 
scenario, that scenario will be overwritten. Note also that the 
scenarios are stored on the JumpStart server, not on your 
other computer, if you are using the JumpStart client 
software on another computer. 
A scenario can contain up to 60 windows. If the scenario you 
are editing has more than 60 windows, you will not be able to 
save it.
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Stop a Scenario
Click Stop on the Home or File ribbons, or on the quick-launch toolbar.

Rename a Scenario
1. Click the File > Rename.

2. Enter a name in the Scenario Name field.

3. Click OK.

Delete a Scenario
1. Click File > Delete.

2. Click OK.

Work with Content
Christie JumpStart can show windows that have videos, pictures, 
applications, input channels, and color and text content on your display 
wall. For videos, pictures, applications, and input channels, you need to 
add the source content to JumpStart before you can add them to a 
scenario.

The items you can add to a scenario are shown in the panels to the left 
side of the canvas. 

Add Media Files to the JumpStart Server
When you add videos and pictures to JumpStart, the content files must 
be located on the hard drive of the JumpStart server or on another 

If you have access to the keyboard that is connected to the 
JumpStart server, you can also stop the currently running 
scenario by pressing Ctrl-Shift-T on that keyboard. 
The user account used by the JumpStart server software 
does not have Microsoft Windows administrative permissions 
on the JumpStart server. Because of this, any applications 
that require administrative permissions to close them cannot 
be closed when a JumpStart scenario ends. 
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mounted drive (such as a USB drive or network drive). Also, any 
applications that you add must be ones that are installed on the 
JumpStart server. If you are using the JumpStart client software on 
another computer, you cannot add content directly from that computer 
using JumpStart. 

By default, the JumpStart software opens the appropriate media folder 
on the JumpStart server hard drive when adding content (for example, 
the default Pictures folder for pictures). However, you can store media 
files anywhere on the hard drive. You can also store content on another 
mounted drive, as long as you can ensure connectivity when playing 
scenarios.

Add Files With USB
1. Store the files you want to add on a USB flash drive or portable 

hard drive. 

2. Connect the flash or portable drive to the USB port on the 
JumpStart server. 

3. When the drive is mounted, copy the files to a location on the 
JumpStart server’s hard drive. 

Add Files Over a Network
If the computer where your media files are stored is on the same 
network as the JumpStart server, you can share those folders with the 
JumpStart server and copy the f iles over your network. For more 
information, see your Microsoft Windows help. 

Add Videos to the Content Pane
1. Click the Videos panel and then click Add. 

- or -

Click the Content tab and then click Videos.
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2. In the Select Video Files dialog box, navigate to the folder you 
want. Remember that this dialog box shows you files stored on the 
JumpStart server, not on your computer. 

3. Select the video file(s) that you want to add. To select more than 
one, hold down Ctrl while you click the files. To select a range, click 
the first file, hold down Shift, and then click the last file.

4. Click OK.

Add a Picture to the Content Pane
1. Click the Pictures panel and then click Add. 

- or -

Click the Content tab and then click Pictures.
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2. In the Select Picture Files dialog box, navigate to the folder you 
want. Remember that this dialog box shows you files stored on the 
JumpStart server, not on your computer. 

3. Select the image file.

4. Click OK.

Add an Application to the Content Pane
You can add software applications to a scenario if they are installed on 
the JumpStart server. When you activate a scenario with an application, 
that application is started on the JumpStart server and becomes visible 
on the display wall. 

The Windows user account used by the JumpStart server software does 
not have Microsoft Windows administrative permissions on the 
JumpStart server. Because of this, any applications that require 
administrative permissions to close them cannot be closed when a 
JumpStart scenario ends. 

As with any other type of window, you can change the location and size 
of an application window on the JumpStart canvas. However, some 
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applications have desktop locations or window sizes that are preset, and 
will therefore not appear at the location or with the window size that you 
have specified on the canvas. 

1. Click the Applications panel and then click Add. 

- or -

Click the Content tab and then click Applications.

The Add / Remove Applications dialog box shows all applications 
that are accessible on the JumpStart server. The Removed column 
shows the applications that are not listed on the Applications panel. 
The Added column shows the applications that are listed. 

2. To show an application on the Applications panel, select it in the 
Removed column and then click the Add button. To make it not 
visible, select it in the Added column and then click the Remove 
button. To select multiple applications, hold down Ctrl and click. To 
select a range, click the first one, hold down Shift, and click the last 
one. 

When you remove an application from the Applications panel, it 
does not remove it from the JumpStart server. 
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3. If you want to use an application that is installed on the JumpStart 
server but does not appear in this list, you can add it. Click Add 
New Application. 

4. In the Select Executable File dialog box, navigate to the folder you 
want and select the executable (*.exe) file. If you are using the 
JumpStart client on another computer, remember that this dialog 
box shows you files stored on the JumpStart server, not on your 
computer. 

5. Click Add.
JumpStart 1.0.1 User Manual 25
020-100781-02 Rev. 1 (12/12)



Using JumpStart
6. In the Application Settings dialog box, specify a Name and any 
Parameters to pass to the application when it is run, as you would 
use when executing the command from a command-line interface. 
(Refer to the application’s user documentation for this information.) 
Make sure you enclose an individual parameter with spaces in 
double quotes (for example, path or file names that contains 
spaces). We recommend that you test launching the application 
with the parameters before adding it to JumpStart. 

7. Click OK. The added application appears in the Added column. 

Add an Input Channel to the Content Pane 
The Input Channel panel shows the input channels that are installed on 
the JumpStart server. If you have the model of server with no DVI 
inputs, then this tab is empty. 

If you have the model of server with 4 DVI inputs, then this list of 
channels is dynamically updated based upon what channels are 
connected. To refresh this list, click Refresh. 

Add a Color Window to the Content Pane
When you add a color window to the Color Windows panel, it acts as a 
template. You select the properties you want initially. After you add a 
window to a scenario by dragging it from this panel, you can change the 
color settings for that window and that scenario only. 
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1. Click the Color Windows panel and then click Add. 

- or -

Click the Content tab and then click Colors.

2. In the Color Settings dialog box, enter a Name for the color 
window. 

3. Under Color Type, select one of the following options: 

• To make the window 1 continuous color, select Solid. Click 
Color 1. 

[
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In the Select Color dialog box, select the color that you want 
and click OK. 

• To make the window a gradual transition between 2 colors, 
select Gradient. Click Color 1 and select the color you want 
to start with on the left or top. Click Color 2 and select the 
color you want to end with on the right or bottom. To have 
the gradient transition from left to right (default), clear the 
Rotate check box. To have the gradient transition from top 
to bottom, select the Rotate check box. 

4. When you are finished specifying the color settings, click OK. The 
new window appears on the Color Windows panel. 

Add a Text Window to the Content Pane
When you add a text window to the Text Windows panel, it acts as a 
template. You select the properties you want initially. After you add a 
window to a scenario by dragging it from this panel, you can change the 
text settings for that window and that scenario only. 

1. Click the Text Windows panel and then click Add. 

- or -

Click the Content tab and then click Text.
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2. In the Text Settings dialog box, enter a Name for the text window. 

3. In the Text box, enter the text you want to appear in the text 
window. 

4. Select the color scheme you want to use by clicking one of these 3 
buttons. When you click one of these buttons, a Select Color-style 
dialog box appears: 

• Font Color: Select the color of the text itself. 

• Text Outline Color: Select the color of the border around 
the text.

• Background Color: Select the color of the window 
background. 

In the Select Color dialog box, select the color that you want and 
click OK. 

5. To change the horizontal alignment of the text in the window, click 
the left, center, or right alignment buttons. To change the vertical 
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alignment of the text in the window, click the top, center, or bottom 
buttons. 

6. To change the font used in the text, click Change Font. 

In the Select Font dialog box, specify the font, style, size, and 
effects you want to use.

The fonts shown are the ones installed on the computer that you 
are using. If you are using the JumpStart client software on another 
computer, ensure that the JumpStart server has the same fonts 
installed on it.

Click OK. 

7. Select the other text options: 

• Outline Text: Select to use a different color to outline the 
text. 

• Fit to Window: Select to make the text scale up and down 
as you change the size of the window on the canvas.

• No Background: Select to make the background of the text 
box transparent instead of colored. 

8. When you are finished specifying the text settings, click OK. The 
new window appears on the Text Windows panel. 
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Remove Content
When you remove content such as videos or pictures from the JumpStart 
client software, you do not delete the files from the JumpStart server’s 
hard drive. When you remove color or text boxes, you do delete them 
permanently. To remove content: 

1. Click a content panel in the left pane.

2. Right-click an item and select Remove.

3. When prompted to confirm, click Yes.

Work with Windows
Windows are what you use to organize content in JumpStart. Each 
window points to an individual media file, input channel or application. 
Windows can also contain text or color. A group of windows on the 
JumpStart canvas, along with the schedule of when and for how long 
they are displayed, makes up a scenario.

Resize a Window
To resize a window with your mouse:

1. Click a window on the canvas.

2. Click, hold, and drag a handle to resize the window.

3. To maintain aspect ratio (keep the height and width proportional to 
each other) while resizing, hold down Shift and click, hold, and drag 
a handle. 

To enter specific height and width values for a window:

1. Right-click a window on the canvas and select Settings.
JumpStart 1.0.1 User Manual 31
020-100781-02 Rev. 1 (12/12)



Using JumpStart
2. Increase or decrease the Width value.

3. Increase or decrease the Height value.

4. Click OK.

Move a Window
To move a window with your mouse, click and drag a window on the 
canvas.

To enter specific values for the location of a window:

1. Right-click a window on the canvas and select Settings. 

2. In the Windows Settings dialog box, increase or decrease the Top 
value.

3. Increase or decrease the Left value.

4. Click OK.

You can have the windows snap to an invisible grid so that you can easily 
line them up. To change the increments of that grid: 

1. Click the Home tab. 

2. Click Snap, and select one of these options: 

• Off: Turns the snap feature off. 

• Small: Sets the snap increment to 8 pixels. 

• Medium: Sets the snap increment to 24 pixels. 
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• Large: Sets the snap increment to 48 pixels. 

Rename a Window
1. Right-click a window on the canvas and select Settings.

2. In the Windows Settings dialog box, enter a name in the Name 
field.

3. Click OK.

You can also double-click the window name in the schedule, or right-click 
the window name and click Rename. Then, type a new name. 

Change the Window Order
By default, JumpStart displays the windows in a scenario in the order in 
which you added them. For example, if you drag a blue color window 
onto the canvas and then a red color window that overlaps it, the red 
one will appear to be on top of the blue one because the red one was 
added later. 

You can change the order in which the windows are displayed by 
JumpStart by clicking and dragging them in the schedule pane. To have a 
window displayed on top of other windows, drag it up in the list of 
windows in the schedule pane. To have it displayed underneath other 
windows, drag it down in this list. 

You can also change the window order as follows: 

1. Click a window on the canvas.

2. On the View tab, click one of these buttons: 

• Bring Forward. Moves the window one position toward the 
top in the window order.

• Send Backward. Move the window one position toward the 
bottom in the window order. 

• Bring to Front. Move the window to the top of the window 
order. 

• Send to Back. Move the window to the bottom of the 
window order. 
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Show or Hide Window Names
1. Click View.

2. Select Window Names to show window names.

- or -

Clear Window Names to hide window names.

Delete a Window
1. Right-click a window on the canvas and select Delete Window, or 

click a window on the canvas and press the Delete key. 

2. When prompted to confirm, click Yes.

Work with Commands
You can add commands to scenarios. You can also send commands from 
another device to the JumpStart server, as long as the server is 
connected to the other device using Ethernet or serial communication. 
There are two types of commands that you can include: 

• Serial commands directed at a JumpStart server to start or stop a 
scenario

• Serial commands directed at other devices, such as projectors

JumpStart Commands
The JumpStart server supports two serial commands, one for starting a 
scenario and another for stopping a scenario. Typically you will invoke 
these commands on one JumpStart server. However, if your installation 
has more than one JumpStart server, you can send these commands 
from one server to another one. You can also send these commands to a 
JumpStart server from any other device capable of sending a serial 
command. 

The syntax of these commands is as follows: 

• (SCN+STRT scenarioname), where scenarioname is the name of a 
scenario that is available on the JumpStart server that you are 
sending the command to. This starts the scenario. 
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• (SCN+STOP scenarioname), where scenarioname is the name of 
a scenario that is available on the JumpStart server that you are 
sending the command to. This stops the scenario. 

Serial Commands to Other Devices
You can include commands to other devices, as long as the JumpStart 
server sending the command is connected to that device using Ethernet 
or serial communication. When defining the command, you must use a 
valid command that the device will recognize, and you must know the IP 
address and port number of the device. 

For information on the syntax of commands for your device, see the 
documentation for that device. 

For example, to instruct a Christie M Series projector to power on, you 
would send the command (PWR1) to the projector. To have the projector 
show a grid test pattern, you would send (ITP 1).

Best Practices When Sending Commands
Make sure that you carefully analyze the interactions between the 
commands that you define, particularly if your installation has more than 
one JumpStart server. 

Note that a JumpStart server cannot run more than one scenario at a 
time. When you start a scenario, any previously running scenario on that 
server is stopped. Also, when the JumpStart client software instructs the 
JumpStart server to start a scenario, the server sends acknowledgement 
back to the client software to indicate success or failure. 

Therefore, if you run a scenario that starts another scenario 
immediately, the JumpStart server might return an error message 
because the first scenario was stopped before the acknowledgement of 
its starting could be sent back. 

If you are starting one scenario from another, we recommend spacing 
the commands apart on the schedule rather than placing the commands 
at time zero.
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Create a Command
To create a command:

1. Click the Commands panel and then click Add. 

- or -

Click the Content tab and then click Commands.

2. In the Create Command dialog box, specify a Command Name. 

3. Specify a Command. For information on JumpStart command 
syntax, see JumpStart Commands on page 34. For information on 
serial command syntax, see the documentation for the device that 
you want to send the command to. 

4. Specify an IP address for the JumpStart server or other device. 

5. Specify a Port Number that the device will be listening on. For 
another JumpStart server, this is normally 3002. 

6. Specify a Description (optional).

7. Click OK. 

After you have added a command to the Commands panel, you can view 
its properties by hovering the pointer over it. 

To rename a command, double-click it in the Commands panel or right-
click and click Rename. Type the new name and press Enter or click 
away. 

To edit a command, right-click it in the Commands panel and select Edit. 

To delete a command, right-click it in the Commands panel and select 
Remove. 
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Add a Command to a Scenario
To add a command to a scenario, drag it from the Commands panel to 
the canvas. It appears on the timeline. To view a command’s properties, 
hover the pointer over it. 

You can also add a command to a scenario by right-clicking in a 
command row under the timeline, clicking Add, and then selecting a 
command name. Only the first 5 commands in the Commands panel are 
listed. 

Work With Commands on the Timeline
After you have added a command to a scenario by dragging it onto the 
canvas, you can change the launch time for the command by dragging it 
back and forth on the timeline. You can also do this by right-clicking the 
command icon and selecting Settings. 
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In the Command Settings dialog box, specify a different Launch Time 
and click Apply. 

To remove the command from the scenario completely, click Delete. 

When you are finished with this dialog box, click Exit.

Work with the Schedule
You use the schedule to define when and how frequently content appears 
in a scenario. You can also use the schedule pane to change the order in 
which content is displayed (which windows are on top and which are 
underneath). For more information, see Change the Window Order on 
page 33. 

Show or Hide the Schedule Pane
1. Click the View tab.

2. Select Schedule to show the schedule pane.

- or -

Clear Schedule to hide the schedule pane.

Resize the Schedule Pane
Move your pointer over the split bar between the canvas and the 
schedule pane until a double-headed arrow appears, and then drag the 
split bar up or down.

Change the Schedule Time Interval
1. Right-click the time ruler in the schedule.

2. Select one of the following options: 
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3. Auto, Seconds, Minutes, or Hours. Auto (selected by default) 
changes the units to match the longest duration you have added to 
the canvas. 

Change the Time Duration of a Window
1. Right-click a time line in the schedule pane and select Settings.

2. In the Settings dialog box, increase or decrease the time. The time 
field is of the format HH:MM:SS:TT (hours: minutes:seconds:ten-
thousandths of a second). Click in a segment and type a number or 
use the arrows to increase or decrease the value. 

3. Click OK.

Move Content Within the Schedule
You can have up to 3,000 pieces of content displayed within a window in 
the schedule. To add additional content to existing windows on the 
canvas, drag the content from the Content pane into the window in the 
schedule. 

You can also rearrange content in the Schedule pane by dragging the 
content forward or back within one window, or by dragging the content 
from one window to another. 

Work with Windows on the Canvas
After you add a color or text window to a scenario by dragging it from 
the Text Windows panel, you can change the color or text settings for 
that window and that scenario only. 

Change Color Window Properties on the 
Canvas
Note that these changes do not affect the properties of the color window 
on the panel, only in this scenario. 

1. Click the Color Windows panel and then click Add. 
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- or -

Click the Content tab and then click Colors.

2. In the Color Settings dialog box, enter a Name for the color 
window. 

3. Under Color Type, select one of the following options: 

• To make the window 1 continuous color, select Solid. Click 
Color 1. 

In the Select Color dialog box, select the color that you want 
and click OK. 
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• To make the window a gradual transition between 2 colors, 
select Gradient. Click Color 1 and select the color you want 
to start with on the left or top. Click Color 2 and select the 
color you want to end with on the right or bottom. To have 
the gradient transition from left to right (default), clear the 
Rotate check box. To have the gradient transition from top 
to bottom, select the Rotate check box. 

4. When you are finished specifying the color settings, click OK. The 
new window appears on the Color Windows panel. 

Change Text Window Properties on the 
Canvas 
Note that these changes do not affect the properties of the text window 
on the panel, only in this scenario. 

1. Right-click the text window’s time line in the schedule pane and 
click Settings. 
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2. In the Text Settings dialog box, enter a Name for the text window. 

3. In the Text box, enter the text you want to appear in the text 
window. 

4. Select the color scheme you want to use by clicking one of these 3 
buttons. When you click one of these buttons, a Select Color-style 
dialog box appears: 

• Font Color: Select the color of the text itself. 

• Text Outline Color: Select the color of the border around 
the text.

• Background Color: Select the color of the window 
background. 

In the Select Color dialog box, select the color that you want and 
click OK. 

5. To change the horizontal alignment of the text in the window, click 
Left, Center, or Right Align. To change the vertical alignment of the 
text in the window, click Top, Center, or Bottom Align. 
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6. To change the font used in the text, click Change Font. 

In the Select Font dialog box, specify the font, style, size, and 
effects you want to use. If you are using the JumpStart client 
software on a laptop or other computer, remember that the 
available fonts are those that are installed on the JumpStart server, 
not on your client computer.

Click OK. 

7. Select the other text options: 

• Outline Text: Select to use a different color to outline the 
text. 

• Fit to Window: Select to make the text scale up and down 
as you change the size of the window on the canvas.

• No Background: Select to make the background of the text 
box transparent instead of colored. 

8. When you are finished specifying the text settings, click OK. 
JumpStart 1.0.1 User Manual 43
020-100781-02 Rev. 1 (12/12)



Using JumpStart
Add Color or Text Windows as New 
Channels 
If you have made changes to color or text windows in a scenario and 
want to re-use them as channels in other scenarios, you can add them to 
your list of available channels. 

1. Right-click a color or text window time line in the schedule and 
select Add as Channel. 

2. In the Color Settings or Text Settings dialog box, specify the 
settings you want for this new channel. JumpStart suggests a new 
window name in the Name field. Use that one, or enter a new one. 

3. Click OK. If you have selected a window name that is already in 
use, you are prompted to overwrite.

Advanced Features

Schedule Scenario Restarts
JumpStart is designed for continuous usage. However, if you have a 
scenario with videos that are meant to remain synchronized, they may 
become offset over the course of a long scenario. Because of this, we 
recommend that you do not run such a scenario continuously for longer 
than 24 hours. 

If you have a scenario that is becoming offset in this way, you can 
restart MediaServer (the application on the JumpStart server that 
manages and serves content) at an off-peak time, such as overnight, 
using the Windows Task Scheduler.

If MediaServer is running a scenario when it restarts, it automatically 
restarts that scenario. However, MediaServer will not automatically 
restart a running scenario more than 3 times within 30 minutes. 
Therefore you should not schedule MediaServer restarts less than 30 
minutes apart. 

To schedule a restart of MediaServer: 

1. From the Start menu, select Control Panel. From the View by 
drop-down list, select Small Icons or Large Icons. 
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2. Click Administrative Tools. Double-click Task Scheduler. 

3. In the Task Scheduler window, select Action > Create Task. 

4. In the Create Task dialog box, on the General tab, enter an 
appropriate Name and Description for the task. 

5. Click the Triggers tab, and follow these steps: 

a. Click New. In the New Trigger dialog box, from the Begin 
the task drop-down list, select On a schedule. 

b. Under Settings, click Daily. Specify the date when you want 
the task to be run for the first time, and the time of day when 
you want the task to be run. Enter how often you want the 
task run, in days, in the Recur every box.

c. Click OK. 

6. Click the Actions tab, and follow these steps: 

a. Click New. In the New Action dialog box, from the Action 
drop-down list, select Start a program.

b. In the Program/script box, enter TASKKILL.

c. In the Add arguments box, enter /F /IM 
Mediaserver.exe. Click OK. 

d. Click New. In the New Action dialog box, from the Action 
drop-down list, select Start a program.

e. Beside the Program/script box, click Browse.

f. In the Open dialog box, locate the mediaserver.exe file (for 
example, C:\Program Files (x86)\Christie Digital 
Systems\Mastersuite\Christie\Jetty\mediaserver.exe). Click 
Open. 

g. Click OK.

7. Click the Settings tab, and follow these steps: 

a. Ensure that the If the running task does not end when 
requested, force it to stop check box is selected. 

b. Ensure that the Allow task to be run on demand check 
box is selected. 

c. Clear all other check boxes on the Settings tab. 
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d. From the If the task is already running, then the 
following rule applies drop-down list, select Stop the 
existing instance. 

8. Click OK. The new task appears in the Task Scheduler window. 

9. To test the task, right-click it and select Run from the context 
menu. 

Automatic Schedule Restarts
If the JumpStart server is turned off or loses power for any reason, the 
MediaServer application restarts automatically when the server is 
rebooted.

If MediaServer is running a scenario when it restarts, it automatically 
restarts that scenario. However, MediaServer will not automatically 
restart a running scenario more than 3 times within 30 minutes. 
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This section provides information and known issues with JumpStart and 
how to resolve them. 

I have 1 MicroTile with 1 ECU driving it and 
cannot set up JumpStart
The JumpStart connection wizard cannot configure your display wall if 
you have a subarray that is 1 MicroTile being driven by 1 ECU. This is 
because the DVI output requires a minimum bandwidth of 25 MHz, which 
is not achievable using 1 MicroTile at native resolution with a refresh 
rate of 60 Hz, which is what the MicroTiles Setup Wizard uses.

To configure this setup manually, use the WebUI for your Master ECU. 

Images on my 1-tile subarray cut off
If you have a subarray that only contains 1 MicroTile, the EDID 
resolution might be set so that the incoming signal is larger than the 
native resolution of the MicroTile (720x540 pixels). As a result, images 
and videos might be cropped. Set the EDID values manually so that all of 
the incoming signal can be displayed. To configure this setup manually, 
use the WebUI for your Master ECU. 

An application in my scenario isn’t closing 
automatically
Some applications do not close automatically when the scenario that 
launched them is stopped. Here are possible reasons why this might 
occur: 

• The JumpStart client software does not have Microsoft Windows 
administrative permissions on the JumpStart server. Because of 
this, any applications that require administrative permissions to 
close them cannot be closed when a JumpStart scenario ends. This 
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is true regardless of whether you are running the JumpStart client 
software on the JumpStart server or on another computer. 

• Some applications with splash-screen dialog boxes cannot be 
closed. 

• Some applications that launch multiple window or processes (for 
example, Adobe Acrobat) cannot be closed. 

I have several large videos playing at once 
and am experiencing performance 
problems
You can have up to 4 HD videos or 16 SD videos playing simultaneously 
on your display wall. However, if NVIDIA Mosaic mode is enabled, we 
recommend that you have fewer videos playing simultaneously. To 
configure NVIDIA Mosaic mode, right-click the desktop of the JumpStart 
server and select NVIDIA Control Panel from the context menu.   

I have just configured my display wall, and 
the JumpStart server is not rebooting 
properly
The JumpStart server has an upper limit of 150 MHz of bandwidth 
assigned to each ECU. If the display wall mapped to an ECU exceeds this 
value, the JumpStart server may not interact properly with the display 
wall. If this occurs, use the WebUI for your Master ECU to manually 
change your EDID values to bring the bandwidth below 150 MHz. 

My desktop looks cropped
Christie ECUs default to a WUXGA (1920x1200) resolution. If your 
MicroTiles configuration has a native resolution smaller than this, your 
desktop will be cropped on the right and/or on the bottom, potentially 
including the Microsoft Windows task bar. If this occurs, use the WebUI 
to manually configure appropriate EDID settings on the ECU. 
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I’ve added an image or video to 
JumpStart, but no thumbnail picture 
appears 
For some very large files, JumpStart cannot create a thumbnail for them 
when you add them to JumpStart. Those files should work properly in a 
scenario.

I’m using interlaced video and don’t like 
image quality
Use of interlaced video signals connected as an external source to the 
JumpStart server is not recommended. This could produce visible image 
artifacts, such as missing lines, especially when viewed up close or if the 
video is upscaled significantly. 

My videos are not remaining synchronized 
If you have a long scenario with multiple videos that are meant to stay 
synchronized, but they are starting to become out of synch, you can 
restart MediaServer (the application on the JumpStart server that 
manages and serves content) at an off-peak time, such as overnight, 
using the Windows Task Scheduler. For more information, see Schedule 
Scenario Restarts on page 44.

I’m playing a scenario, but some of my 
windows are black or white
If the JumpStart server is not displaying content correctly, it may be 
running low on memory, especially if you are displaying several video or 
image windows at the same time. Adjust your scenario so that it has 
fewer windows being displayed simultaneously.
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JumpStart displayed an out-of-memory 
error, and isn’t working 
If the JumpStart server displays an out-of-memory exception error, the 
JumpStart server software should restart automatically. If it has not 
restarted (for example, if there are no JumpStart windows open), then 
you can manually launch the JumpStart server software by double-
clicking the Christie JumpStart Server shortcut on the server desktop. 

I cannot connect to the JumpStart server 
or I cannot see any scenarios
If you cannot open or save a scenario or connect to the JumpStart server 
using the JumpStart client software, confirm the following items: 

• The server is powered on and connected to the display wall. 

• If you are using the JumpStart client software on another computer, 
you are connected to the server. 

• The server has sufficient hard disk space to operate properly. 

If this issue persists, restart the JumpStart server. If this issue recurs 
after restarting the server, then the Java installation on the JumpStart 
server may have been upgraded to a more recent version while the 
Christie Web Server was running. Because the Christie Web Server 
requires Java, upgrading Java while the Web Server is running will cause 
the Java installation process to fail. 

To upgrade Java safely, or to correct this issue: 

1. On the JumpStart server desktop, right-click Computer, and click 
Manage on the context menu. 

2. In the Computer Management window, double-click Services and 
Applications, and then double-click Services. 

3. In the list of services, right-click Christie Web Server and then 
click Stop.

4. From the Start menu, click Control Panel. Double-click Java (32-
bit). 
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5. On the Java Control Panel, click the Update tab. Click Update 
Now. 

6. When the Java update is complete, return to the Services list, right-
click Christie Web Server and then click Start.

Setup and Configuration Issues

Viewing the MicroTiles Connection Wizard 
If you are doing initial setup using more than one ECU with JumpStart, 
Microsoft Windows chooses one of the ECUs as the one driving the 
primary display. This may not be the ECU you have designated as the 
Master ECU. As a result, the display wall attached to your Master ECU 
may be black. 

To avoid this, perform initial setup with just the Master ECU connected to 
the JumpStart server using the DVI video cable. 

Using the Corel WinDVD player

JumpStart uses the Corel® WinDVD® player to play Blu-ray discs. If you 
uninstall or change this application, you will not be able to play Blu-ray 
discs. We highly recommend that you not uninstall or change this 
software application. 

Also, to display Blu-ray discs across more than one screen on your wall, 

you must have NVIDIA® Mosaic mode turned on. To configure NVIDIA 
Mosaic mode, right-click the desktop of the JumpStart server and select 
NVIDIA Control Panel from the context menu. 

JumpStart stopped playing a scenario, and I can’t see the 
Windows task bar on my display wall
If JumpStart suddenly stops playing a scenario, then the 
Mediaserver.exe software that displays content may have ended 
prematurely. If this happens and you cannot see the Windows task bar 
to restart the server: 

1. Connect to the server using the JumpStart client software on 
another computer. 

2. Start another scenario in JumpStart. 
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3. Stop that scenario. The Windows task bar should reappear. 

I started a scenario that includes a 
command to start another scenario, but 
got an error message 
If you start a scenario that contains a command to start another 
scenario, the JumpStart server might return an error message because 
the command was located at time zero. When starting one scenario from 
another, make sure the command is not at time zero, but placed a few 
seconds into the scenario timeline. 
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